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INTRODUCTION
If you have things to do,  you may need ThingsToDo.  It is 
programmed for Windows 3.0 and 3.1 in Visual Basic 2.0 ("Windows" 
and "Visual Basic" are trademarks of Microsoft Corporation) and is 
designed to allow you to keep track of a wide range of items or 
information and organize them into schedules and lists of tasks.   I 
developed ThingsToDo when I became frustrated with various other 
"personal information managers" that I  tried. The intention was to 
keep it simple so that I could quickly enter notes, ideas and 
commitments.  But I wanted the powerful search and view features 
that would make this data entry worthwhile and keep me from 
reverting to using my pocket calendar and post-its.  I hope you will find
that ThingsToDo gives you a proper blend of simplicity and power.   
Here are some of its key features:

1. Items of all types, including information about meetings, 
projects, people, and tasks, are kept in a single database.  This
allows you to mix types of information on reports, to 
access any type quickly, and to scan across all types for those 
which have a particular word or phrase, or those which are scheduled 

for a particular week or day.

2. You are able to enter and to retrieve items which contain a 
minimum of information.  All you really have to enter 
is some brief summary.  You are not required to enter dates,
times, priorities, etc., for various tasks but may use these fields
if desired.  

3. For each item, you can enter an associated note which can be as 
much as 15 pages in length.  You may elect, on an item-by-



item basis to print associated notes when an item appears 
on a particular report.

4. Key word searches are applied not only to a summary that has 
been entered for an item, but also to any text which has been 
entered in associated notes.

5. The notes for a particular item are stored in a separate file in an 
ASCII format, allowing you easily to pull the note into the 
word processor or text editor of your choice, massage it, and 
print it.

6. A set of memorable Hot Keys have been defined to allow you 
quick access to the majority of the features of ThingsToDo.

7. ThingsToDo helps you as much as it possibly can on the entry of
dates and times, minimizing the need to worry about 
punctuation.

8. You are able quickly to mark an item as completed and to purge 
completed items from your database.

9. Tasks which have been assigned to a particular day but have not 
been completed are automatically displayed, so you will not lose track
of them merely because the date has passed.

REGISTRATION
ThingsToDo is a "shareware program" and is provided to you for 
evaluation at no charge.   Feel free to share it with your friends, but 
please do not give it away altered or as part of another system.  The 
essence of "user-supported" software is to provide personal  computer 
users with quality software without high prices, and yet to provide 
incentive for programmers to continue to develop new products.  If you
find this program useful and find that you are using ThingsToDo and 
continue to use ThingsToDo after a reasonable trial period, you must 
make a registration payment of  $35.00 to The Manager, Inc.  You are 
encouraged to pass a copy of  ThingsToDo along to your friends for 
evaluation.   

The $35.00 registration fee will license one copy for use on any one 



computer at any one time.  You must treat this software just like a 
book.  An example is that this software may be used by any number of 
people and may be freely moved from one computer location to 
another, so long as there is no possibility of it being used at one 
location while it's being used at another. Just as a book cannot be read 
by two different persons at the same time.  Site-License arrangements 
may be made by contacting The Manager, Inc.

Users of ThingsToDo must accept this disclaimer of warranty:  
"ThingsToDo is supplied as is.  The author disclaims all warranties, 
expressed or implied, including, without limitation, the warranties of 
merchantability and of fitness for any purpose. The author assumes no 
liability for damages, direct or consequential, which may result from 
the use of ThingsToDo."

ThingsToDo is produced by a member of the Association of Shareware
Professionals (ASP).  ASP wants to make sure that the shareware 
principle works for you. If you are unable to resolve a shareware-
related problem with The Manager, Inc. by contacting us  directly,  the 
ASP may be able to help. The ASP Ombudsman can help you resolve a 
dispute or problem with an ASP member, but does not provide 
technical support for members' products.  Please write to the ASP 
Ombudsman at 545 Grover Road, Muskegon, MI 49442 or send a 
CompuServe message via CompuServe Mail to ASP Ombudsman 
70007,3536.

Anyone distributing ThingsToDo for any kind of remuneration must 
first contact The Manager, Inc. at the address below for authorization. 
This authorization will be automatically granted to distributors 
recognized by the Association of Shareware Professionals as adhering 
to its guidelines for shareware distributors, and such distributors may 
begin offering ThingsToDo immediately (However The Manager, Inc. 
must still be advised so that the distributor can be kept up-to-date with



the latest version of ThingsToDo.).

You may register by contacting me ( David Merk) at 

The Manager, Inc.
P.O. Box 1822

Waterville, ME 04903

(207) 872-4544
(evenings and weekends)

When you register, I will send you a printed, illustrated manual and
a copy of ThingsToDo which does not display the annoying 
registration notice at startup.  I will also answer your questions, keep 
you informed about updates, and take your comments into account as 
we plan new updates.  As a part of  paying the registration fee, you will
be entitled to phone support regarding ThingsToDo for the first six 
months following the date your registration fee is received.  You may 
purchase additional support following the first six months for a fee of 
$5.00 per call.  Phone support is available evenings and weekends at 
(207) 872-4544.  (You may call anytime to leave messages on the 
machine.)  You may also send me your questions or comments via 
CompuServe.  My ID is 76177,1321.  Finally, feel free to write me at the
above address.  I welcome your comments, questions, and 
suggestions.

Note:  The following  are new features which have been added to 
Version 1.4 of  ThingsToDo based on the comments of  registered 
users.  They are described in more detail elsewhere in this manual.  
Version 1.4 allows you to:

1. determine the View which will be displayed when you first 
start up ThingsToDo;

2. set the type face and type size which will be used for the 
following elements of a printed View: the ThingsToDo title,
the View title, column headings, the item, and notes;

3. select, on a view-by-view basis, the order in which items 
will appear on the screen and on the printouts;

4. determine the format for the entry and display of dates to 
allow users to chose the "day/month/year" format common
in Europe;



5. to delete an item, without marking it as completed.  This 
allows you to get rid of some items while keeping an 
accessible archive of others.

6. suppress all notes for a particular printing;
7. indent lines in your notes;
8. manage 5,000 items at a time;
9. bring up the DatePicker by double-clicking on the date field

when entering or editing an item;
10. more quickly enter items of the same type by offering the 

type of the most recently entered item as the default 
type for the item you are about to enter;

11. access all views by using Hot Keys;
12. customize three additional task types, for a total of nine 

types;
13. use the Enter key to move around the fields on the item 

screen; and
14. to print a particular item and its associated note from the 

item data entry window.



GETTING STARTED
The installation routine provided with ThingsToDo will place the 
ThingsToDo files in a "Things" subdirectory of your "Windows" 
subdirectory, that is, in  C:\WINDOWS\THINGS.  If you have previously 
been using ThingsToDo, your previous data file will be upgraded to 
match the structure used by Version 1.4.   

You may then start ThingsToDo in any of the customary ways:  
double-click the "Things.Exe" filename on the File Manager 

listing,  place the command "C:\Windows\Things\
Things.exe" on the "Load" or "Run" lines of your 
WIN.INI file,

use the "FILE/RUN" option of Program Manager or File Manager, 
or set up a new icon on your desktop and double-click 
it.

Executing THINGS.EXE brings up the main screen which has the label 
ThingsToDo at the top and which provides columns for date, starting 
and ending time, and the summary of each item.  There are also 
narrow columns on the left and right of the screen which will be 
discussed later.  

A menu bar at the top gives you access to all of the options of 
ThingsToDo.  You may wish to click on each of the options on the 
menu and scan the submenus which appear.  Note that for most of 
these items, a Hot Key combination is shown.  This is usually a much 
faster way to invoke an option.  For example, you can print the current 
view of your items by holding down the CTRL key and pressing the "P". 
You can add a new item by holding down the CTRL key and pressing 
"A" as an alternative to clicking on the edit option on the menu and 
then selecting the "Add Items" option from the submenu.  It's worth 
learning the Hot Keys, most of which have an obvious mnemonic 
derivation.  A table of Hot Keys is included at the end of this manual.

ON-LINE HELP
All of the information found in this ThingsToDo manual is also 
available on-line when you are using ThingsToDo .  Select the "Help" 
option on the menu of the main screen.  You may scroll through the 
help text using normal procedures - scroll bar, PgDn, etc. Or you may 



use the Search feature.  Just type a letter or number and a box will 
appear, prompting you to enter the rest of the search word or phrase.  
Press ENTER when done and the pointer will move to the first place in 
the Help file where that phrase occurs.



ENTERING ITEMS
Once you've started up ThingsToDo, the next step is to begin adding 
items from your calendar or to-do list.  All kinds of items 
(appointments, projects, phone numbers) go into a single pool.  The 
various search and report routines then select them for particular uses.
Press the CTRL-A combo or select "Add an Item" under the Edit menu, 
and the Item Data screen will appear.  

You may complete as much or as little of this screen as you wish.  To 
move from field to field, press the TAB key.  To return to a previous 
field, hold down the SHIFT key and press the TAB key.  

New Feature!!!   You may also move from field to field by pressing 
the ENTER key.  Note that when you are in the NOTE field, the ENTER 
key places a "hard return" in the line, starting a new line.  To move 
from the NOTE field, use the CTRL-ENTER combination. 

Alternatively, you can select particular fields by clicking on them, using
your mouse or trackball.  The defined fields are as follows:

1. A SUMMARY, which can be approximately 50 characters in 
length.  Something like "Meet with Mabel", "Talk with Art about the 
bottom line", etc.

2. The DATE.  You may either enter the date by typing the month, 
day, and year or by selecting the date from a calendar using your 
mouse or trackball.  Note that if you type inthe date, you only need to 
type the month and day, separated by a SLASH (/). ThingsToDo will 
automatically supply the year for the next occurrence of this date.  You 
only need to type the year if it's more than one year in the future or if 
it's in the past.  To select the date from a calendar, press the F10 key.  
The Date Picker will appear, and you may double-click on the 
appropriate date.  Use the scroll bar at the bottom of the Date Picker to
move forward or backward in the calendar to bring up other months 
and years.

New Feature!!!   ThingsToDo now recognizes your preference for 
date format based on the setting you have chosen using the Windows 
Control Panel. If you select the Day/Month/Year format in the Control 
Panel, this is the format that will be used by ThingsToDo.

New Feature!!!   To bring up the Date Picker using your mouse, 



double click on the word "Date" next to the date box.



3. START TIME.  ThingsToDo works on the assumption that the 
times you enter are intended to be between 7:00 am in the morning 
and 6:59 pm in the evening.  It also supplies necessary punctuation.  
Type "715" and "7:15a" will be displayed after you move to the next 
field.  Enter "715p" if you intend to enter 7:15 pm.  To delete a time 
which you have previously entered, use the LEFT ARROW to get to the 
beginning of the field.  Press the DELETE key until you've cleared the 
previous entry.  Alternatively, highlight the entry using your mouse or 
trackball and type the correct entry, and the new time will replace the 
one previously entered.

4. END TIME.  The same rules apply as for entering START TIME.

5. TASK TYPE.  There are nine categories, some of the labels for 
which may be re-defined by using the Preferences option on the File 
menu.  Whenever you enter a new item, ThingsToDo assumes it is a 
"meeting".  The category selected determines how the item will appear
on various reports.  Those which are marked as meetings will appear 
on displays of meetings.  All other items, except those which are 
flagged as "On File", will appear on listings of tasks.  Those which are 
marked as "On File" do not routinely appear on screens or printouts.  
This feature is provided so that you can keep track of phone numbers 
for oodles of people without having them added to your list of tasks for
the day or whatever.  For someone whom you call periodically, put 
them "On File" (put their name, last name first, in the Summary field).  
When you need to call them, call up this "On File" item from the PHONE
LIST, put in some notes about the thing you need to call about, and 
click on the CALL button.  They will then appear under your TASKS LIST.
If you need to call on a particular date, enter a date in the date field.  
After you've made the call, you can either delete the item if you don't 
expect to call that person again, or restore them to "On File" status.

New Features!!!  When you enter an item,  ThingsToDo remembers 
which task type you selected.  When you enter the next item, it checks
that type as the default.  This makes it easier for you to enter in all of 
your phone calls or meetings, for example, as a batch. Also, note that  
ThingsToDo now provides three additional customizable task types.

6. NOTE.  You may enter in this box any notes you wish to elaborate
on the item.  As you fill the box, the notes will scroll up.  You can put a 
total of about 15 pages of text in one of these notes.  The note is 
actually kept in a separate file which is given a name which begins with
the first letters of the summary of the item and which has an ".NOT" 



extension.  At any time after you have built a note, you can call it up 
with a word processor, edit it, and then print it out in some fancy 
format.  This allows you, over time, to store thoughts about a particular
project, and then later to organize them into exquisite prose.  Within 
the Note window, you canuse the standard WINDOWS editing features. 
For example, you can select text with your mouse or trackball, make a 
copy of selected text by pressing CTRL-INS, and paste in copied text by
pressing SHIFT-INS.  (The only exception is that if you press the TAB 
key, you'll move out of the Note window and onto the next item of 
information.  Use the SPACE BAR if you want to indent something 
within the Note window.)    As you will see later, when you print a list of
items, the associated notes will print out unless you specify otherwise. 
Since the TAB key is used to move from item to item, it does not serve 
to indent a line within the NOTE field.  However, you can achieve that 
effect using the CTRL-I key combination.

7. PHONE.  Entering a phone number under "Work Phone" will cause
a particular item to be listed whenever you scan for phone numbers 
(regardless of which task category has been flagged for that item).  In 
addition, the item entered under "Work Phone" will automatically be 
listed with any item which is displayed on the screen or printed out for 
which "Call" has been marked as the "Task Type".  ThingsToDo only 
allows numeric values to be entered in the area code and phone 
number fields.

New Feature!!!   ThingsToDo now provides a place for a "suffix" for 
each phone number.  You may enter any sort of character in this box 
and use it for extensions, international call letters, etc.  This suffix will 
appear on the screen and on printouts along with the phone number 
when an item has been assigned the "Call" type.

8. PRIORITY.  A priority of 0 to 100 can be assigned to any item.  An
item with a higher priority will be shown ahead of other items for the 
same date on the screen listings and printed reports.  Using your 
mouse or trackball, move the box in the center of the scroll bar 
towards the right, and a "Priority Rating" will be shown below.

9. PERSONAL.  Click the "Check Box" to mark the item as personal 
to keep it from being listed on printed meeting schedules.

10. COMPLETED.  Click on this "Check Box" to mark the item as 
completed.  Items which have been checked as completed will not 
appear on screen listings or printouts.  Eventually, they should be 



deleted to make room for new items.  Do not mark an item as done if it
contains information you're going to want to access later.  Instead, 
change the Task Type to "On File".  That way it will be preserved in your
database without cluttering up the printouts and screens.  

Use this screen to enter a bunch of items in your database.  After 
you've entered each item, click the "Add Another" box or hold down 
the ALT key and press "A"; that item will be saved, and a blank form 
will be presented.  When you're finished entering items, click the "OK" 
box (or press "ALT-O"), and you'll be returned to the main screen.  



VIEWING YOUR DATA
Depending on the kinds of items you've entered, some of them may 
now appear on the main screen.  (The default screen is "Today's 
Schedule".)  Any uncompleted tasks with a date prior to today or any 
meeting scheduled for today will be displayed.  The "Personal Items" 
option shows only those items for which the "personal" check-box has 
been checked.  Select the "Search" Option on the menu and try the 
different options on the submenu.  If you entered items with phone 
numbers, for example, click on the "Phone Numbers" option, and those
items will be displayed in alphabetical order.  Note the "Meetings for 
This Week", "Meetings for Next Week", "Tasks for This Week", and 
"Tasks for Next Week" options.  "This Week"is always defined as the 
seven-day period beginning with the most recent Monday.  "Next 
Week" is defined as the seven-day period beginning with the next 
occurring Monday.  

Here are a couple other notes about the displays:  The "All 
Tasks/Meetings" option shows every uncompleted item in the 
database, except those which are marked as "On File".  The "On File" 
option shows just the uncompleted "On File" items.  The "Completed 
Tasks" option shows any item on the system marked as completed, and
the "Phone Numbers" option shows any item where a number has been
entered in the "Work Number" field, regardless of the task type that 
has been selected, and regardless of whether or not the item has been 
marked as completed.  Items are listed alphabetically in the phone 
listing.  When you call up this listing and type a letter, ThingsToDo 
shifts the focus to the first item starting with this letter, and it is then 
usually a simple matter to click on the item of interest.  By selecting 
various choices and looking at the results, you should get a feel for 
how ThingsToDo will treat the various items that you have entered.

ThingsToDo also allows you to create a view of items that contain a 
particular phrase or word or which occur on a particular date.  Choose 
the "Key Phrase Search" option from the Search menu, and a box will 
appear.  Enter the word or phrase and click "OK", and the items which 
contain that phrase either in the Summary or in an associated note will
be displayed on the screen.  Note that you can also click the "Include 
Completed" box if you want to show items which have been marked as 
completed and which have not yet been purged from the system.  
Similarly, if you want to see the schedule for a particular date, select 
the "Schedule for Selected Date" item from the Search menu.  The 
Date Picker will appear.  Double-click the desired date on the calendar, 



and the screen will display all items which either have that date or 
which bear earlier dates and which have not yet been marked as 
completed.  (If you click the check box on the Date Picker, only those 
items which have the selected date will be listed.)

New Feature!!!   The "High Priority" View has been added to 
ThingsToDo to allow you to list any items which have a priority value 
other than 0.



NOTE:  Although ThingsToDo can store a nearly unlimited amount of 
data in the data file, when you conduct a search, you cannot load more
than 5,000 items at a time for scrolling on the screen. (This has been 
increased from the previous limit of 2,400 items.)  This is not terribly 
confining, since you would not want to be responsible for more than 
5,000 chores at a time and would not want to scroll through that many 
items on the screen or a printout.

New Feature!!!  When you click on an item on a given view, that item
is highlighted.  This makes it easier to remember which item has been 
selected.  This is especially important when you use the delete process
which is described later.

New Feature!!!  ThingsToDo has been modified to recognize and 
respond to the direction keys and the PgUp and PgDn keys to 
facilitate movement through a view.  Note that the highlighted item will
change as you press these keys.  If you wish to edit the highlighted 
item, press CTRL-E.  This feature has been added to reduce the extent 
to which you are required to move your hand between the keyboard 
and your mouse to select and edit items.

PLACING ITEMS IN ORDER   !!! New Feature!!! 

ThingsToDo now allows you to determine the order in which items will
be displayed in a particular view.  The "Sort Preferences" option on the 
File menu lists each of the views and gives you five possible sort 
choices.  The formats you select for the various views are saved in the 
"Things.ini" file.  They will be used in all future sessions unless you 
again access this option and change them.

EDITING ITEMS
At any time, you may update the information on a particular item.  
Select an item displayed on the screen by clicking on it and choose the
Edit option on the MENU and the Edit Item option on the submenu, or 
click on the item, and then press CTRL-E, or--and this is the easiest 
way--just double-click the item on the screen.  The "Item Data" screen 
will appear with the information for that particular item, and you may 
move around the form to change anything you wish.  For example, you 
can mark the item as completed, switch it to "On File", change to a 
different date or time, add additional notes, or change the priority.  
When you're done making changes, click the "OK" button, and you'll be



returned to the main screen.  The changes should be reflected there.  
If, for example, you marked the item as done, it will not appear when 
you return to the main screen.  If you change the information in the 
Summary field, that change will be shown.

Normal Windows cut-and-paste operations can be applied to text in the
note and summary fields.  You can cut text from the note on one item 
and copy it into another item's note or into another open Windows 
application.

MARKING ITEMS AS COMPLETED
The column on the far right provides you with a quick way to mark 
items as completed.  Instead of double-clicking the item and clicking 
the "Completed" check box on the "Item Data" screen, you just have to
double-click the item line in the far right column, and a "D" will be 
displayed (for "Done").  If you mark an item as done by mistake, 
double-click the "D" again, and it will be removed, and the item will 
continue to appear on your various views.  

PURGING COMPLETED ITEMS
ThingsToDo will operate more quickly if it does not have to wade 
through lots of completed items as it searches for the items which 
qualify for a particular view.  Select the  "Purge Completed Items" 
option from the Edit menu, and ThingsToDo will, within a moment or 
two, delete the completed items.  Note that it will also erase any note 
files associated with any of these completed items.  If you wish to save
the text in such a file, you should either cut & paste it into another 
note before marking the item as completed, or should bring it into your
word processor, work on it, and save it under another name before 
executing the command to purge completed items.  You can use the 
"Completed Tasks" option on the SEARCH menu prior to executing the 
purge command.

DELETING AN ITEM    !!!  New Feature  !!!  

You now are able to delete items, as well as mark them as completed.  
Simply highlight the item by clicking on it and then press the DEL key.  
You will be asked whether you are sure you wish to delete the item.  



Press ENTER or click on the OK control and the item will no longer 
appear on views.  Be aware that, as with the process of marking an 
item as completed, it will not be removed right away.  Rather, the item 
Summary will be blanked out.  Similarly, any associated note file will 
not be deleted.  Periodically, you should select the Purge Deleted Items
option from the Edit Menu.  This will get rid of all items with a blank 
summary and will delete any associated note files.

NOTING WHERE THE NOTES ARE
Let's look again at the Main Form with some items displayed.  We have 
noted that there are columns containing the Date, Starting and Ending 
Times, and Summary of the item.  In addition, there is a column on the 
far left and another on the far right.  The column on the far left displays
an ampersand (&) for any item which has additional notes above and 
beyond the information which is entered in the Summary field.  This 
prompts you to examine that item further if you want to see everything
that you have on record.  If an item has an ampersand (&) in the 
"Note" column, double-click that item, and you will be able to read the 
detail on that note. 

PRINTING A VIEW
At any time, assuming that your computer is connected to a printer 
and that the printer is on-line, has paper, and is feeling good about you
that day, you may print out the tasks which are showing on the screen.
Tasks will be printed in the order in which they appear on the screen.  
Meetings are organized by date and time; other tasks are organized by 
type of task, and then within each type by the date and priority.  You 
can print the current view by holding down the CTRL key and pressing 
"P" or by selecting the "Print" option from the File submenu.  After you 
press the CTRL-P combination, make sure to allow enough time for the 
printing to occur.  Have patience!  Printing is never as fast under 
WINDOWS as we'd like it to be.  Note that when you print the items, 
the printout also displays any notes you have entered under an item.

New Feature!!!  When you print a view a dialog pops up giving you 
the chance to print more than one copy of the view, to suppress the 
printing of all notes, or to cancel the printing.

PRINTING AN ITEM     !!!New Feature!!!



When you are editing or entering an item, you are able to print that 
particular item.  This is especially handy if you have an item with an 
extended note and wish to hand it on to someone else without giving 
them the printing of an entire view.  From anywhere in the Item Data 
screen, press the CTRL-P combination, and the item and note will be 
printed. 

SUPPRESSING THE PRINTING OF NOTES
The "Note" column also serves another purpose.  If you double-click on 
the ampersand, you will note that a slash (/) will be placed across the 
ampersand.  The effect of this is to instruct ThingsToDo to not print 
that particular note when you execute the "Print" command.  Thus, if 
you've got ten items showing on the screen and three of them have 
notes and you only want certain notes to be printed, you can double-
click the other notes.  You might do this because you are going to 
circulate the printout to others and don't want the notes to be shared, 
or because you don't intend to act on these notes for a while, and the 
printing of them will waste space.  The instruction to stifle the printing 
of a particular note only lasts for as long as that particular view is on 
the screen.  The minute you select another view under the "Search" 
option, the ampersand is restored.  If you've double-clicked a note to 
preclude it from printing and then change your mind, double-click it 
again, and it will "toggle" back to printable status.

New Feature!!!     ThingsToDo allows you to indicate, at the time of 
printing, that you wish to suppress the printing of all notes on the 
current view.  Just click the appropriate box on the printing dialog box.

SETTING YOUR PREFERENCES
The "General Preferences" option on the File menu allows you to 
control the following features of ThingsToDo:
1. You can change the labels for three of the task types.  The 
"Meet", "Call", and "On File" labels are fixed because these three types 
determine which items appear on particular views and the order in 
which they appear.  The other three, however, may be reset to reflect 
categories of activity that you customarily organize.  If, for example, 
you don't do programming but do need to schedule a number of 
activities, change the label for the fourth item from "Program" to 
"Schedule". 



2. You can select the type to be used for printing reports;

3. You can control how frequently the list appearing on the screen is
refreshed to reflect changes in data.  The default is set for "auto-
refresh".  This means that whenever you add a new item or edit an 
item displayed on the screen, ThingsToDo will re-create the list 
displayed on the screen.  Since it must read through all items on file to 
do this, you may end up looking at the hourglass for a moment.  If you 
disable the auto-refresh feature, the main screen will display a "Refresh
List" command button.  The list will be updated only when you click 
this button or when you conduct a different search of your data.  This 
allows you to rapidly enter or edit a number of items and then refresh 
the list once when done.   This is a lot like setting the "re-calculation"  
feature of a spreadsheet to "manual".

4. New Feature!!!    The View which appears when you first start 
up ThingsToDo can be set on the General Preferences screen.

5. New Feature!!!     The size of the type which will be used for 
the various components of the printing of a view or an item can be 
altered by selecting options from the General Preferences screen.

6. New Feature!!!     Your preference for the format for dates, as 
selected in the Windows Control Panel, will be recognized by 
ThingsToDo. Note: this is based on the "short" format and limited to 
Day/Month/Year and Month/Day/Year.



SOME ADDITIONAL TIPS
The following are suggestions on how to handle particular situations 
using ThingsToDo:

1.     If you have someone whom you work with often, create an item 
bearing that person's name, for example, "Kathy B."  If you enter a 
phone number for that person, he or she will automatically appear on 
the phone numbers list, regardless of the setting on "Task Type".  You 
can then always quickly find that person by selecting the "Phone List" 
(CTRL-N) and then typing the first letter of his or her name.  

Use the "Notes" field to keep track of the things you want to work on 
with this individual and change the task type from "Meet" to "Call" to 
"Do/Tell", depending on how you next plan to interact with them.  
When you've met with them and taken care of the items you noted, 
change the "Task Type" to "On File" or reset the date and time to the 
next scheduled meeting, etc.  You can use the "Note" section to keep a 
trail of all of the items that you've discussed.  

2.    If you have particular groups that you meet with periodically, you 
can enter the name of the group, eg., Executive Committee.  If a 
meeting is scheduled, enter the date and time; otherwise, you may 
access it by displaying it on the undated items view.  As you think of 
things to cover in that meeting, add them to the "Notes" field.  When 
the date is set for the next meeting, key it in.  Following that meeting, 
either set the date to the next scheduled meeting or, if none has been 
set, erase the date and access it later under the "UnDated Tasks" 
search.

UNINSTALLING   ThingsToDo  

If (heaven forbid!) you try ThingsToDo and decide that it does not suit
you, you can easily uninstall it.  Just delete the files in the C:\Windows\
Things subdirectory and then delete the subdirectory itself. 
ThingsToDo in no way modifies the WIN.INI or SYSTEM.INI files used 
by Windows.

A BOUNTY ON ERRORS



I have tried to make ThingsToDo "bulletproof".  In furtherance of this 
effort, I am offering a bounty of $5 for any "bug" reported by a 
registered user.  To qualify, the bug must be reproducable and must not
have previously been reported to me. 



LISTING OF HOT KEYS
New Feature!!!  Virtually all views now have defined Hot 
Keys.Fortunately or unfortunately there are now enough views and 
options in ThingsToDo  that it is hard to find enough obvious hot keys.
For example, it would be appealing to use CTRL-P for the phone list, 
but that hotkey has been assigned to printing to maintain compatibility
with other Windows applications.  Instead, CTRL-N (for "numbers") has 
been assigned to this view.  Some of the newer hotkeys are even more 
far-fetched, but I am including on the hotkeys list any association I 
used in assigning them. This may help you to remember them.

Main Menu HOT KEYS
CTRL-A Add Call up the Item Data Screen for 

the entry of new data pertaining to a new item.

CTRL-C Completed Displays completed items.

CTRL-D Date Search for items scheduled for a 
particular date

CTRL-F Displays tasks for NEXT week

CTRL-H High Priority Displays all items with a 
priority rating greater than 0.

CTRL-I Displays Personal Items.

CTRL-K Key Key word search

CTRL-L Alllll Displays ALL Tasks/Meetings

CTRL-M Meetings Displays meetings for this week.

CTRL-N Numbers List all the phone numbers on file.

CTRL-O On File All items which are marked 



as "On File".

CTRL-P Print Print the report currently displayed 
on the screen

CTRL-S Schedule Displays today's schedule.

CTRL-T Tasks Displays the tasks for this week.

CTRL-U Undated Displays items for which no date 
has been entered and which have a task type 
of something other than "On File".

CTRL-W Displays meetings for NEXT week.

CTRL-X Exit Closes ThingsToDo and returns 
you to the Windows Program Manager. You can 
achieve the same result with the ALT-F4 
combination which customarily closes Windows
applications.

CTRL-Z Choose Prompts you to select a particular 
Task Type and displays all items of that type.

Item Data Screen HOT KEYS
ALT-A Add Save the current item and add 

another

ALT-C Cancel Leave the Item Data Screen 
and return to the Main Screen.  If you were 
editing an existing item, it will be unchanged.  
If you had begun to add a new one, it will be 
deleted.

ALT-O OK Save the item data as it appears on
the screen and return to the Main Screen.

F10      Date Picker When entering the date for an 
item, call up the Date Picker to select a date 



rather than type it in.

CTRL-I TAB When entering text into a Note, use
this combination to insert a group of spaces. 
(This is required because the TAB key is used 
for moving from field to field.)

CTRL-P Print Item Print a single item and its note 
when that item is displayed on the Item Data 
Screen


